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Before You Begin
These operating instructions describe how to install and operate the Attendant P attendant 
console on your HiPath 3000/HiPath AllServe. Attendant P includes an online help function 
where you will find general information on the program layout and explanations of the in-
dividual functions (to access the online help Æ page 14).

While the instructions describe all Attendant P functions, you may find that some functions 
you wish to use are not available. This is due to one of the following reasons:

• The function has not been configured for your Attendant P system. Address any ques-
tions to your system administrator.

• Your communications platform does not support this function. Address any questions 
to the Siemens sales representative responsible for upgrading your system.

• You do not have the latest version of the Attendant P software. Contact your Siemens 
sales representative to update the software.

Attendant P
In purchasing the Attendant P, you have acquired an advanced PC attendant console for 
your communications platform. Connecting the telephone to a PC means that you can also 
perform all your switching functions from the PC. 

The Attendant P is set up either via the control/data adapter that connects the PC to a sys-
tem telephone in the communications platform or via a PC card (UP0/E PCI card) with a 
handset cradle and handset that are connected to the communications platform like a sys-
tem telephone.

In most countries, connection via the UP0/E PCI card is the only option now sold for 
Attendant P. Contact your sales representative to find out whether it is still possible to con-
nect via the control or data adapter in your country.

The Attendant P software is compatible with different Windows operating systems 
Æ page 78 so that you can conveniently transfer telephone calls and look up phone num-
bers in the electronic directory while simultaneously running other PC applications such as 
Microsoft® Office programs.

The Attendant P attendant console provides you with:

• A variety of switching and administration functions;
• An electronic directory (ETD) with a convenient search option;
• A high degree of user friendliness thanks to the:

– Clearly designed Windows-based user interface;
– Straightforward operation using a keyboard and mouse;

• Simultaneous use of other PC applications;
• Integration of the electronic directory (ETD) and switching functions.
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User Interface of Attendant P
Menu bar Busy lamp fieldToolbar

Switching monitorSystem bar Status bar
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How To Use These Operating Instructions
You will find a graphic representation of the steps in logical sequence 
in the left column. Below is an explanation of the symbols:

Click the right mouse button once.

Click the left mouse button twice.

Click the left mouse button once.

Enter letters or numbers from the PC keyboard (user names and station 
numbers).

Select an option from the menu bar, a pop-up menu or a tab in a program 
window.

Press Return to accept input from the keyboard or confirm a program call.

Click the button with the left mouse button.

Press the key on the PC keyboard.

1. A numbered list describes steps you must complete in the order given.

• Bulleted text indicates an enumeration.

Æ page 4 Reference to a page.

Space Bar

F3

Note or remark.
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Overview of Features
• Incoming and outgoing call display

• Call answering/dialing/transferring

• Toggling between two calls

• Three-party conference

• Call holding and parking

• Redialing of the last ten numbers dialed

• Dialing with busy lamp field and repertory dial keys

• Callback and send message

• Call override

• Activate/deactivate call forwarding

• Activate/deactivate night answer

• Electronic directory (ETD) functions:
– Look up and display stations
– Look up and display station data
– Automatic provision of the station number for dialing from the ETD.
5



About This Manual
This manual is intended both for personnel working with the Hicom 
Attendant P attendant console who are familiar with the Windows user in-
terface and for the system administrator, who configures and oversees the 
Attendant P attendant console.

The manual contains all the  information you will need to install and operate 
the Attendant P attendant console:

• To make important information easy to find, the first section of this ma-
nual deals with Operating the Hicom Attendant P.

• The second section describes Installing and Configuring the 
Attendant P.

• If you run into any problems installing or operating the Hicom 
Attendant P, refer to the third section of this manual, Error Correction 
in Attendant P.

Requirements
You or the system administrator must install the attendant console hard-
ware and Hicom Attendant P software for the Microsoft Windows user in-
terface on your PC (see section two of this manual, Installing and Confi-
guring the Attendant P).

The PC’s power management system must not be activated during 
Hicom Attendant P operation.

Operating the program requires some elementary knowledge of PCs and 
Windows.

Operating the Hicom Attendant P
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Operating the Attendant P
Operating the Attendant P
This section of the manual covers the operation of the Attendant P attendant 
console program. It introduces the user interface and describes all the major switching 
functions.
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Startup
Startup
You can configure your attendant console PC so that the Attendant P swit-
ching program starts up automatically when you switch on the PC. 
If the program has not been configured to start up automatically, you must 
start it manually or set up Attendant P for automatic start up.

Automatic startup

Switch on the attendant console PC. As soon as Windows 95/98 loads, 
your operating system Æ page 78 automatically starts up and the program 
window with the attendant monitor opens.

Manual startup

When you install the program, it is added to the Programs section of the 
start bar of your operating system Æ page 78.

Start up the Attendant P from the Start menu. The program window with 
the attendant monitor opens.

Set up Attendant P for automatic start up

1. Click on the “Start” button on the task bar and select “Settings”, 
“Taskbar”, “Start Menu Programs”.

2. Press the “Advanced” radial button: the screen will display: 
“Exploring C:\Windows\Start menu”.

3. Open the “Programs” directory and locate the Attendant P directory.

4. Click the right mouse button to copy the “Vf3.exe” program to the right 
column.

5. Go to the "Autostart" folder in the left column and insert the “Vf3.exe” 
file into the right column, using the right mouse button.

6. Close “Exploring”.

7. On the “TaskBar Properties” screen, click “Apply” , then “OK”.

8. Exit and re-start the PC.
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User Interface
User Interface

Desktop
Your desktop is the Attendant P program window Æ page 13. This window 
contains the

• Menu bar Æ page 14,
• Toolbar Æ page 15,
• Attendant monitor Æ page 18,
• Busy lamp field Æ page 23, and
• System bar Æ page 16.

You can also open another window containing the:

• electronic directory Æ page 66 or
• notebook Æ page 63,
• the telephone directory CD Æ page 72 or
• the search window for the LDAP server Æ page 73.

Menu bar Busy lamp fieldToolbar

Switching monitorSystem bar Status bar
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User Interface
Menu bar
The menu bar contains a series of main menu options. Clicking one of the-
se main menu options with the left mouse button opens a corresponding 
submenu (pull-down menu) with additional menu options.

• File
This menu allows you to configure general settings for the Attendant P. 
The Exit command terminates the Attendant P application.

• Edit
Use this option to activate DTMF suffix-dialing during a call and select 
the night answer destination.

• Window
With this menu, you can call the busy lamp field, notebook and electro-
nic directory.

• Repdial keys (optional)
If you have configured repertory dial keys, you can dial your party direct-
ly from this menu.
(This menu option appears only if you have configured repdial keys in 
the Attendant P).

• Find
From this menu, you can selectively search for the names, companies, 
cities, postal codes or station numbers of any stations that are stored 
in the directory.

• Paging (optional)
This menu option allows you to broadcast a speaker announcement to 
telephones in a specific group. 
(This menu option appears only if you have configured paging groups 
and have activated them in the Attendant P.)

• Language
Use this option to set the language that you want Attendant P to use 
for menus and dialog boxes (windows)

• ? (Help)
Use the "Help" option to access Attendant P online help function, whe-
re you will find general information on the program layout and explana-
tions of the individual functions.

If there is a check mark next to the context-sensitive "Quick Help" opti-
on, the program displays information on the areas where the mouse 
pointer is located.

Use the "About..." option to view general information about 
Attendant P.
14



User Interface
Toolbar
In the talk state or idle state you can call important functions from the tool-
bar by clicking them with the mouse. Some functions appear in the toolbar 
only if they are configured for your telephone.

In the Idle State

Call electronic directory Æ page 66.

Call busy lamp field Æ page 23.

Display list of most recently dialed numbers Æ page 38.

Activate/deactivate night answer Æ page 62.

Send message Æ page 55.

Open door lock Æ page 33.

Activate/deactivate call forwarding Æ page 59.

Release trunk Æ page 57.

Transfer trunk Æ page 56.

Start telephone directory CD Æ page 72.

Open search window for LDAP server (company telephone directory) 
Æ page 73.
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User Interface
In the Talk State

Call electronic directory Æ page 66.

Call busy lamp field Æ page 23.

Initiate callback Æ page 52.

Override busy station Æ page 50.

Initiate conference Æ page 48.

Terminate conference Æ page 48.

Set volume Æ page 32.

Open door lock Æ page 33.

Start telephone directory CD Æ page 72.

Start search window for LDAP server Æ page 73.

System Bar
The system bar tells you which functions are activated in your system. 
The following symbols may appear:

• Ringing off:

• Night answer on:

• Callback active:

• Park slot in use:

• Call is held:

• Call waiting tone off:

• Privacy on:

• Call forwarding on:

• Message waiting:

• Microphone off (mute):

When the mouse is pointed at a symbol, a context-sensitive help text 
("quick-reference help") appears at the mouse position if this function has 
been configured Æ page 14.
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User Interface
Status Bar
Advisory and system messages on the status bar:

• The status bar displays the current status of Attendant P during the loa-
ding operation. The program is ready when System ready is displayed 
in the status bar.
If the data of the communications platform has been modified, the Ple-
ase wait message appears in the system bar to inform you that the pro-
gram is being updated with the new system data.

• The status bar also displays explanations of the buttons on the atten-
dant monitor when you operate these buttons with the mouse.

• The park slot number appears for 10 seconds when a user in the CS 
parks a call or picks up a parked call.
17



User Interface
Attendant Monitor
The attendant monitor is the main work area of the attendant console. 
From here, you can control the switching functions and obtain information 
from your communications platform.

• You can answer all pending calls from the call display. 
The system telephone’s softkeys and operating keys (two lines in the 
case of optiset E comfort/8 lines in the case of optiset E memory; 
Æ page 27, e.g. Service menu) may be masked in instead of the call 
display.

• The traffic display indicates the current trunk seizures.

• The buttons allow you to initiate the switching functions.

• Any held or parked calls are indicated in the call list.

• By clicking the right mouse button in the attendant monitor, you can 
display a pop-up menu containing additional functions that may be 
helpful depending on the switching state Æ page 22.

•

A pending call appears in the call display. When you call a party or answer 
a pending call, the data appears in the left column of the traffic display. If 
you call another station for switching purposes, the data for this station ap-
pears in the right column of the traffic display; the data of the held station 
appears in the call display.





Call display

Traffic display

Buttons





























Call list
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User Interface
Call Display
Waiting calls are displayed in the list boxes on the call display. Using the 
mouse, you can scroll through the list boxes and select individual calls. A 
call can be answered by clicking the "External", "Internal" or "Private" but-
tons.
The status line reproduces the display of the connected telephone (if con-
figured and connected via an optiset E control/data adapter). If you wish to 
activate/deactivate the status line or change its color, please contact your 
service technician.

The number of waiting calls is indicated to the left of the list boxes both 
numerically and by means of a green bar. If the number of callers exceeds 
a programmable threshold value, the color of the bar changes to red. You 
can define this threshold value (= warning) by selecting the File menu, the 
Settings option and the Calls tab.

A: 0891234567

I: 38041 Peters

P: 38559Miller

List boxes: External calls
Internal calls

Personal calls

A bar indicates 
the number of 
pending calls.

Camp-on without tone

Answer call

Open list box

Status line
19



User Interface
Traffic Display

The left column of the traffic display shows the first party when you ans-
wer or place a call.
The right column of the traffic display shows the second call when, for ex-
ample, you call a second party for the purpose of connecting him or her to 
the first party.

The party who is actually connected to the attendant console appears in 
the top half of the traffic display, while the station the caller wanted to re-
ach--or the attendant wanted to call--appears in the bottom half. For examp-
le, the attendant wanted to reach a user named Smith (station number 
120), who, however, had activated call forwarding to Miller (station number 
101). The attendant reaches Miller (entered in the top half of the display), 
but not Smith (lower half of the display).

For internal calls, the station number and (if possible) station name are 
displayed. For external calls, the station number and possibly the name are 
displayed only in the case of an ISDN connection or digital tie trunk 
(CorNet-N).

If your party has activated call forwarding, the name and number of this 
station also appear in the traffic display. If call forwarding is not activated, 
the party’s name and station number are repeated.

The two Status fields in the traffic display indicate the status of the calls 
(such as Busy, Free, Call).

Name and station num-
ber of first party

Data of
second call

Data of
first call

Name number of desi-
red first party

Call status

Name and number of 
desired second party

Call status

Name and station num-
ber of second party








{ }









20



User Interface
Call list
The call list indicates all calls which are currently on hold or parked.
If a text has been entered by the station user in connection with holding or 
parking, this is also displayed.
For information about configuring text input in connection with holding or 
parking, please get in touch with your service technician.

You can retrieve the call from the hold Æ page 45 or park Æ page 49 status 
by double-clicking the left mouse button on the entry in the call list.

Buttons
The most important functions of the Attendant P are mapped on buttons. 
You can activate these buttons by clicking them with the left mouse button.

Answer Buttons

Call Processing Buttons

Dialing Buttons

Automatic line seizure deactivated/off:

Description of the situation
Holding/parking position
Held/parked station

Trunk > Position 0 - Smith is waiting for Miller

For external calls

For internal calls

For personal calls

Æ page 45

Æ page 34

Æ page 49

Æ page 47

Æ page 34
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User Interface
Automatic line seizure activated/on:

Pop-up Menus
If additional functions are relevant to the current switching state of the
Attendant P, these functions will be offered in a pop-up menu.

Calling a Pop-up Menu

Click the right mouse button anywhere on the attendant monitor to open 
the pop-up menu.

Activating a Function in the Pop-up Menu

With the left mouse button, click a menu option in the pop-up menu to 
activate the function.

Example: Pop-up menus in the idle state:

Example: Pop-up menu during a call: 

Æ page 35 Æ page 35

Æ page 35 Æ page 36 Æ page 35

The particular functions presented in the pop-up menus depend on 
the switching state of your system.

A pop-up menu appears when you click the right mouse button on 
any free area in the attendant monitor. Any other collapsible menus 
that are activated by the left mouse button are called 
pull-down menus.

(Not for U.S.)
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User Interface
Busy Lamp Field

Representation
The busy lamp field has a total of 240 status keys that that you can divide 
into two or four groups, assigning an internal station to each key. The sta-
tus keys display either the number (in station number mode) or the name 
(in name mode) of the internal stations assigned to them, enabling you to 
display a total of 240 internal parties as follows:

• In station number mode: two groups of 120 stations each.
• In name mode: four groups of 60 stations each.

To select a station, click the status key assigned to this station.

To change these status button colors, select Settings from the File menu, 
and then the BLF tab. From there, you can also select whether the back-
ground color or only the color of the status button label should be changed.

Example: If a status button has a gray background, the station if free. If the 
background is dark red, the station is busy with an external call; if it is light 
red, the station is busy with an internal call. If the station is being called, 
the background of the status button turns yellow. 

If you position the mouse on a status key while the BLF displays the inter-
nal party’s station number, a window automatically pops up containing the 
station name of this party.

If the BLF displays the name, the station number appears in the pop-up 
window of the selected status key.

Special features must be taken into consideration if your 
Attendant P operates with HiPath AllServe (system networking via 
PC network) Æ page 75!
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User Interface
Calling the Busy Lamp Field

The busy lamp field opens automatically when you start Attendant P. If it 
doesn’t appear for some reason, follow the steps below to open it:

Click the busy lamp field button in the toolbar.

or

Select the BLF option from the Window menu.

The busy lamp field appears:

When you click one of the labeled status buttons, the number for this sta-
tion is automatically dialed Æ page 37.

Double-clicking a status button has the same effect as 
single-clicking it.

Status button
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User Interface
Activating and Deactivating the Busy Lamp Field
You can configure the busy lamp field to open automatically when 
Attendant P starts up.

From the File menu, select the Settings option to display the Settings 
window.

Select the BLF tab.

Select the BLF Activated box if you want the BFL to open automatically 
when Attendant P starts up.

Leave the BLF Activated box blank if you do not want the BFL to open au-
tomatically when Attendant P starts up.

Click the OK button to confirm your selection.

Click the Cancel button to return to the attendant monitor.

To close the BLF, you must first deactivate the BLF Activated option 
on the BLF tab and then restart Attendant P.
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User Interface
Labeling the Busy Lamp Field
To assign status buttons to internal stations, you must label the buttons 
with the station numbers. To do this, first set the busy lamp field to station 
number mode Æ page 96.

Call the busy lamp field.

To open the Station number dialog box, using the left mouse button, simul-
taneously click the status button to be labeled while pressing the Shift key.

Enter the station number and click OK to confirm your entry.

The station is now saved under this status button.
Instead of the station number, you can also display the name assigned to the 
number in the system Æ page 96.

Deleting a Station

Call the busy lamp field.

Press Ctrl while clicking the left mouse button on the status button of the 
station to be deleted. The station is deleted from the busy lamp field.

Ctrl

Deleting a station from the busy lamp field does not delete it from 
your system; in other words, you can reconfigure it at any time.
26



User Interface
Service Menu
You can replace the call display with the Service menu, which simulates 
the telephone display (two lines for optiset E advance plus/comfort system 
telephone, eight lines for optiset E memory system telephone) as well as 
the telephone’s scroll keys  and confirm key .

The Service menu dialog box automatically appears when you initiate a 
procedure such as sending messages.

You can also call the Service menu manually to execute functions or proce-
dures that cannot be initiated via toolbar buttons or pop-up menus (for a 
description of these functions and procedures and how to execute them, 
refer to the user manual for the communications platform).

Calling the Service Menu

Call the pop-up menu by clicking the right mouse button anywhere on the 
attendant monitor.

Click the Service menu option with the left mouse button.

The call display is replaced by the Service box, softkeys and operating keys 
are masked in:

Use the  ,  and  buttons to scroll in the system menu and 
initiate functions and procedures.

Click the Back button in the Service dialog box to return to the call display.
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Making and Answering Calls
Making and Answering Calls

Answering Calls
The call display provides you with a convenient means of answering inco-
ming calls. It contains pull-down list boxes that display all pending external, 
internal and personal calls. You can selectively choose and answer any call.

Call Types

• Internal: A call from another party to your communications platform.
• External: A call from a party outside your communications platform 

who has dialed the system number and operator number (such as 0) or 
whose call was not answered by an internal party (and Attendant P is 
programmed as the intercept position).

• Private: A call from a party outside your communications platform who 
has dialed the system number and internal operator number (such as 
100).

When you receive an incoming call, you hear a signal via the telephone 
speaker and/or the PC speaker (depending on the setting) and also see a 
display on the telephone screen and in the call display list box. If, on the 
basis of the number, an entry is found in the telephone directory file, the 
corresponding name is also displayed.

A: 0891234567

I: 38041 Peters

P: 38559Miller

List boxes: External calls
Internal calls

Personal calls

A bar indicates 
the number of 
pending calls.

Camp-on without tone

Answer call

Open list box

Status line

If you are working with another Windows application when a call is 
received, the system automatically changes to the Attendant P.
Note that the system cannot change to the Attendant P while a 
screensaver is activated. In this case, the call is signaled by the 
speaker only.
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Making and Answering Calls
Answering a call

Click one of the buttons "External", "Internal" or "Private" with the left mouse 
button to answer the first call in the adjacent list box.

or

Click the arrow for the list box with the left mouse button to open the list 
and select the call that you wish to answer.

Answer the selected call.

or

Press the space bar on the keyboard.
This answers the first call in the queue, depending on the priority. The calls 
are prioritized as follows:
Recall - External calls - Internal calls - Personal calls.

or

possibly In the event of recall (the originating station is displayed):
Press the "Enter" button. In the event of such a call, caused by intercept or 
a forwarded call, the originating station can be dialed again directly.

The answered call appears in the traffic display:

or

or

or

or

Space Bar

Enter

When you answer a call, it makes no difference whether the tele-
phone handset is on-hook or off-hook because the telephone’s 
hookswitch is activated only during emergency operation 
Æ page 74
(applicable only if the system telephone is connected via the control/
data adapter).
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Making and Answering Calls
Using Call Waiting (Second Call)

Answering a Second Call (Call Waiting)
While you engaged in a call, you are also available to additional callers. Du-
ring the call, you are informed acoustically (by a call waiting tone if this tone 
has not been deactivated) and visually (in the call display) that a second call 
is waiting. The call continues to be signaled in the call display until you have 
answered it.

1.

Terminate the current call with the "Clear" button.
The waiting call is indicated in the call display.

or

Click the Hold button to place the current call on hold Æ page 45. The wai-
ting call is signaled in the call display.

or

Click the Park button to park the current call Æ page 49. The waiting call is 
signaled in the call display.

2.

Accept the call.
You are speaking to the second caller.

or

or

or

Space Bar
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Making and Answering Calls
Turning the Call Waiting Tone On and Off
The call waiting tone lets you know that a second caller is trying to reach 
you while you are engaged in another call.

The call waiting tone is automatically deactivated when Attendant P pro-
gram starts up and the call waiting tone off icon  appears in the system 
bar. The waiting call (second call) continues to be signaled visually in the 
display.

Activating the Call Waiting Tone

Call the pop-up menu.

Select the Camp-on without tone on/off menu option 

The call waiting tone is reactivated and the call waiting tone off icon  is 
removed from the system bar.

Deactivating the Call Waiting Tone

Call the pop-up menu.

Select the Camp-on without tone on/off menu option.

The call waiting tone is deactivated and the call waiting tone off icon  
appears in the system bar.

Picking up Calls
You can pick up calls for other telephones on your own telephone using the 
busy lamp field. When a station is being called, the background or label of 
the status key turns yellow (individually programmable Æ page 23. 
You cannot pick up a call if you currently conducting a call or a call is being 
signaled in your call display.

You cannot pick up a call

• if the status key is displaying one of the busy states; in this case the 
destination party already picked up the call,

• if you are engaged in another call or
• If the call display is signaling a call

Prerequisite: The background or label of a status button in the busy lamp 
field is yellow.

With the left mouse button, click the status button (with a yellow back-
ground or label) for the station being called.

The call is picked up and you can speak to the other party.
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Making and Answering Calls
Activating/Deactivating the Ringer Signal
You can deactivate the speaker on the optiset E telephone, and thus the 
ringer signal on the telephone receiving an incoming call (not possible if 
you are using a UP0/E card). When the ringer signal on the telephone is 
deactivated, the the telephone signals the call only visually, although you 
can have it signaled audibly using wave files (to activate wave files 
Æ page 91).

Attendant P can be configured so that the ringer signal for incoming calls 
is automatically deactivated when Attendant P starts up Æ page 94. The 
ringing off icon  then appears in the system bar. 

Activating the Ringer Signal

Call the pop-up menu.

Select the Ringing on/off menu option. 

The ringer signal on the telephone is reactivated and the ringing off icon 
 is removed from the system bar.

Deactivating the Ringer Signal

Call the pop-up menu.

Select the Ringing on/off menu option. 

The ringer signal on the telephone is deactivated and the ringing off icon 
 appears in the system bar.

Setting the Volume
You can change the volume of the handset speaker; in other words, you 
can select the volume at which you would like to hear the other party.

Click the volume button in the toolbar.

The call display is replaced by the Volume dialog box, softkeys and opera-
ting keys are masked in:

Use the  and  buttons to adjust the volume at which you hear the 
other party in eight steps. Click the Back button in the Volume box to return 
to the call display. The value you selected is stored.
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Making and Answering Calls
Actuating the Entrance Telephone Connection/Door 
Opener
If the service technician has configured one or more entrance telephones, 
from your telephone you can speak to visitors using the entrance telepho-
ne and then you can activate the door opener. The entrance telephones are 
assigned internal station numbers.

Speaking to Visitors via the Entrance Telephone

Prerequisite: Your telephone rings and the entrance telephone station 
number appears in your call display.

Take the call within 30 seconds. You speak to the visitor on the entrance 
telephone.

or

Opening the Door

You can operate the door opener while engaged in a call with the entrance 
telephone or when your phone is idle.

Click the door lock button in the toolbar. 

The following dialog box is displayed:

Enter the entrance telephone’s internal station number and click OK to con-
firm your entry.
Simply click OK if the entrance telephone number appears in the window 
while you are talking to the entrance telephone party.

The door is opened.

or

or

Space Bar
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Terminating a Call
Terminating a Call

One Party

Click the Clear button (= hanging up) to terminate your current call.

Two Parties

or
Click the Back button or press the "+" or "F4" button (this must be configu-
red) to terminate your current call and change to the waiting call.

or

If you are speaking to two parties alternately (toggling) or simultaneously 
(conferencing), you can interconnect the two parties by clicking the Con-
nect button (the Clear button is replaced by the Connect button).
Attendant P returns to idle mode and you can answer other calls again.

+

F4
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Making Calls
Making Calls
Your Attendant P attendant console allows you to initiate internal and ex-
ternal calls. When placing an external outgoing call, you also have the op-
tion of setting it up as a personal call. Such calls are specially marked during 
call charge evaluation so that they can be billed separately.

Making External Calls
Enter the external code and the external station’s number. The number is 
dialed as soon as you press Enter.

or

Enter the external code and the external station’s number. Then click the 
General button. 
The station number is dialed.

Personal Calls

Using the Private button, you can conduct external personal calls. These 
calls are specially marked for call charge evaluation.

Enter the external code and the external station’s number. Then click the 
Private button. 
The station number is dialed.

Outgoing external calls can automatically be identified by the length 
of the number to be dialed. If the number exceeds a certain length, 
the external code is prefixed automatically. For the programming of 
the minimum length, please consult your service technician.

If you must dial the external code before dialing the external station 
number, the system is programmed so that automatic line seizure is 
deactivated. In this case, the Internal button does not appear in the 
attendant monitor. 
If automatic line seizure is activated, you do not need to dial the ex-
ternal code. However, for internal calls you must then click the Inter-
nal button before dialing.
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Making Calls
Turning DTMF Suffix-Dialing On and Off

While engaged in an external call, you can activate a sequence of digits to 
control answering machines or information and switching systems. To do 
this, you must activate DTMF suffix dialing.

Select DTMF suffix dialing from the Edit menu.

A check mark appears next to the option to show it has been activated.

Making Internal Calls
Enter the number of the internal station and press Enter to confirm.

You can also dial the station from the electronic directory Æ page 66, the 
busy lamp field Æ page 37, or the repertory dial keys Æ page 36.

Making Calls With Repertory Dial Keys
Use the repertory dial keys to call a station directly. If repertory dial keys 
have been configured in Attendant P Æ page 94, the Repdial keys option 
appears on the menu bar.

Select the Repdial keys option from the menu bar to open a pull-down 
menu with the repertory dial keys.

Select the name of the station that you want to call.
The station number is dialed.

You can program the system so that automatic line seizure is activa-
ted. It will then be unnecessary to dial the external code when pla-
cing external calls. However, you will then have to click the Internal 
button before placing internal calls. This button is displayed only if 
automatic line seizure is activated.

You can also store codes for controlling voice mail systems and an-
swering machines on repertory dial keys.
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Making Calls
Making Calls With the Busy Lamp Field
Click the busy lamp field button in the toolbar to display the busy lamp 
field.

Idle State

You are not in the talk state and want to place a call.

With the left mouse button, click the status button for the station that you 
want to call.

The station number is automatically dialed.

Switching State

You are engaged in a call and want to forward the call to a station in the 
busy lamp field. There are three ways to do this:

• Screened transfer

With the left mouse button, click the status button for the station to which 
you want to transfer the call.

You can notify the station of the call.

or
Connect the station by clicking the Connect button (the Clear button is 
replaced by the Connect button) or press the + key on the keyboard.

• Unscreened transfer

With the left mouse button, click the status button for the station to which 
you want to transfer the call.

Wait for the ring tone.

Connect the stations by clicking the Connect button (the Clear button is 
replaced by the Connect button) or press the + key on the keyboard.

or

• Speed transfer

With the right mouse button, click the status button for the station to 
which you want to transfer the call. The call is immediately forwarded to 
the selected station. If this station is busy, the busy station is automatically 
camped on after approximately five seconds (can be configured by the sys-
tem administrator). If the station cannot be reached, the call is signaled in 
the call display as a recall after approximately forty seconds (can be confi-
gured by the system 
administrator).

+

+

Double-clicking a status button has the same effect as 
single-clicking it.
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Making Calls
Making Calls With Redial
The last ten station numbers dialed are automatically stored. If the station 
you dialed is busy or unavailable, you can initiate a redial the next time you 
call instead of having to reenter the station number.

Click the redial button in the toolbar to open a pull-down menu with the last 
station numbers dialed.

Select the desired station number. 
The number is automatically dialed.

Making Calls From the Electronic Directory
1.

Enter the name of the station you are looking for in the traffic display and 
press Enter to confirm your entry. If the name is stored in the ETD, the 
electronic directory Æ page 66 opens automatically and the entry is high-
lighted.

or

Open the electronic directory and highlight an entry.

2.

possibly If you wish to call the other party on his mobile phone, for example, instead 
of his usual telephone number, you can select this number from the selec-
tion list field "Number" if it is entered in the ETD Æ page 69.

3.

or
Click the "Dial" button or confirm with the "Return" button.
The number is dialed.

By default, Attendant P saves both internal and external station 
numbers. However, you can program Attendant P to store only ex-
ternal station numbers in the redial list Æ page 92.
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Consultation/Transfer/Conference
Consultation/Transfer/Conference

Transferring Calls
The following methods can be used to transfer an answered call to an in-
ternal or external station. If you are unable to transfer calls to external sta-
tions, this is because you are not authorized to do so (consult your system 
administrator).

• Screened transfer: The person you are talking to would like to consult 
another party. Call the desired party and announce the call.

• Unscreened transfer: The person you are talking to would like to con-
sult another party. Dial the number of the desired party, wait for the ring 
tone, and connect the two parties without announcing the call.

• Speed transfer: The person you are talking to would like to consult 
another party. Dial the number of the desired party and connected the 
two parties without waiting for the ring tone.

• Transfer after parking/holding: The external party you are talking to 
would like to consult another party. You place the call on hold or park 
the call. Dial the number of the wanted internal or external party, an-
nounce the call and then connect the two parties.
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Consultation/Transfer/Conference
Screened Transfer

1.

Accept the call.
The call appears on the traffic display.

or

2.

While still conducting the call, use the left mouse button to click the status 
button for the station to which you want to transfer the call. 
The station number is dialed.

or

While still conducting the call, enter the number of the station you want to 
reach and press Enter to confirm your selection. The station number is di-
aled. (You can also dial the station from the electronic directory Æ page 66 
or using the repertory dial keys Æ page 36.)

The two stations appear in the traffic display:
The first party is automatically placed on hold.

3.

Notify the destination station of the call.

4.

or
Connect the station by clicking the Connect button (the Clear button is re-
placed by the Connect button) or press the + key on the keyboard.

As soon as the stations are connected, their data is deleted from the traffic 
display and you are free to answer another call.

If the station is busy or does not answer, click the Back button to return to 
the first party.

or

or

Space Bar

+
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Consultation/Transfer/Conference
Unscreened Transfer

1.

Accept the call.
The call appears on the traffic display.

or

2.

While engaged in the call, click the status button for the station to which 
you want to transfer the call, using the left mouse button. The system dials 
the number.

or

While engaged in the call, enter the number of the station you wish to re-
ach and press Return to confirm. The system dials the number (you can 
also dial the party from the electronic directory Æ page 66 or using reper-
tory dial keys Æ page 36.)

Both stations appear in the traffic display.
The first party is automatically placed on hold.

3.

or
Wait for the ring tone and click the Connect button to connect the parties 
(the Clear button is replaced by the Connect button), or press the + key on 
the keyboard.

When the stations are connected, the data for the other party disappears 
from the traffic display and you can accept another call.

If the third party is busy or does not answer, click the Back button to return 
to the first party. If the third party does not answer the transferred call 
within 40 seconds (time can be programmed by the system administrator), 
the call appears as a recall in the call display.

or

or

Space Bar

+
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Consultation/Transfer/Conference
Speed Transfer

1.

Accept the call.
The call appears on the traffic display.

or

2.

While still conducting the call, use the right mouse button to click the sta-
tus button for the station to which you want to transfer the call. The station 
number is dialed and the call is automatically forwarded to the station 
dialed.

or

While engaged in the call, enter the number of the station you wish to re-
ach and press the + key to connect the stations. The system dials the sta-
tion number, and the call is transferred automatically.

If the party does not answer the transferred call within 40 seconds (time 
can be programmed by the system administrator), the call appears as a re-
call in the call display.

or

or

Space Bar

+
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Consultation/Transfer/Conference
Transfer after parking/placing on hold
Prerequisite: You have placed an external call on hold Æ page 45 or par-
ked it Æ page 49. The held/parked call is indicated in the call list.

1.

Click the left mouse button on the status button of the user whom you 
wish to call. The number is dialed.

or

During the call, enter the number of the internal or external party whom 
you wish to call, confirming your input with the "Return" button. The num-
ber is dialed. (You can also use the Electronic Telephone Directory 
Æ page 66 or the repertory keys Æ page 36 to dial this party.

2.

Announce the call to the wanted party.

3.

Click the "Hold" button.

or

Press the "F3" button (this must be configured).

4.

Double-click the left mouse button on the entry for the held/parked call in 
the traffic display.
The "Clear" button changes to "Connect".

or
Use the "Connect" button to interconnect the two parties or press the "+" 
button on the keyboard.

As soon as the two parties have been connected, the data of the call par-
ties is deleted from the traffic display and you can accept a new caller.

F3

+
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Consultation/Transfer/Conference
Consultation Hold
You are conducting a call and want to obtain information from another in-
ternal or external party without the first party overhearing. If you are unable 
to transfer calls to external stations, this is because you are not authorized 
to do so (consult your system administrator)

Prerequisite: You are currently conducting a call. 

Enter the station number and press Enter to confirm your entry. 
The station number is dialed. 
(You can also dial the station from the electronic directory Æ page 66, the 
busy lamp field Æ page 37, or the repertory dial keys Æ page 36.)

When the station answers, you can conduct a consultation call. The first 
party is automatically placed on consultation hold, meaning that he or she 
cannot overhear your conversation.

When the other party hangs up, you automatically return to the party on 
hold.

Terminating Consultation Hold

or
Click the Back button or press the – key to terminate the consultation and 
return to the waiting party.

–
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Consultation/Transfer/Conference
Hold
You can place external and internal calls on hold whenever you want, for 
example, to call another station.

Placing External Calls on Hold
Prerequisite: You are currently conducting an external call.

Click the "Hold" button.

or

Press the "F3" button (this must be configured).

The other party is placed on hold and cannot listen in. The symbol "Hold" 
 appears on the system bar and the held call is indicated in the call list.

Click the Clear button. You are now available to answer other calls.

You can also place more than one external call on hold.

Activating a Held Call

Prerequisite: You are not engaged in a call.

Click the Hold button to open a pull-down menu with the external calls on 
hold.

Select the held call that you would like to answer. You are reconnected to 
the held station.

or

Double-click the mouse on the line in the call list which contains the held 
call you wish to take.
You are reconnected to the held party.

F3
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Consultation/Transfer/Conference
Placing Internal Calls on Hold
Prerequisite: You are currently conducting an internal call.

Click the Hold button. The other party is on hold and cannot overhear your 
conversation. The symbol "Hold"  appears on the system bar and the 
held call is indicated in the call list.

You can place only one internal call on hold.

Activating a Held Call

or
Click the Back button or press the – key. You are reconnected to the held 
station.

or

Double-click the mouse on the line in the call list which contains the held 
call you wish to take.
You are reconnected to the held party.

–
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Consultation/Transfer/Conference
Toggle
The toggle function allows you to alternate between two calls. The station 
currently waiting cannot overhear your conversation. 

Prerequisite: You are currently conducting a call and another party is 
waiting (for example, on consultation hold).

Click the Toggle button to change to the waiting party. 

or

Press the "F5" button (this must be configured).

Interconnecting Two Parties

or
Click the Connect button to interconnect the two stations (the Clear button 
is replaced by the Connect button) or press the + key.

Set up conference

You can set up a three-party conference between yourself and the other 
two parties by clicking the "Set up conference" button Æ page 48.

F5

You cannot activate the toggle function if you used the Hold button 
to place one of the two parties on hold.

+
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Consultation/Transfer/Conference
Conference
You can add another party to an existing call to form a three-party confe-
rence in which all three parties can speak to one another.

Prerequisite: You are currently conducting a call and another party is wai-
ting (for example, on consultation hold).

Click the "Initiating conference" symbol command button.

or

Press the "F9" button (this must be configured).

The message Conference is displayed in the status box for both parties. 
The three-party conference is initiated.

The symbol command button "Initiating conference"  is replaced 
by the symbol command button "Terminate conference" .

Terminate conference

You can bring the conference to an end with the symbol command button 
"Terminate conference"; all conference members are then disconnected.

Click the Clear button to leave the conference; the other two parties 
remain interconnected.

F9

You can also initiate the conference after toggling (several times) 
Æ page 47.
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Consultation/Transfer/Conference
Park
You can park a call that you have answered but have not forwarded. The 
parked call can be connected to another party Æ page 43.
Your Attendant P can be configured so that a waiting call automatically 
places the current call on hold. For more information on this capability, ple-
ase get in touch with your service technician.

Prerequisite: You are currently conducting a call. 

Click the Park button to park the call. 

or

Press the "F6" button (this must be configured).

The park icon  appears in the system bar. The Attendant P automatically 
parks the call in the next available park slot.

Each telephone system has park slots for ten calls, which both you and 
other internal parties can park. When a user parks a call in the system, the 
occupied park slot number appears on the status bar for ten seconds.

You can park up to ten calls with the Attendant P. Click the Park button to 
display the parked calls.

Answering Parked Calls 

With the left mouse button, click the Park button to open a pull-down menu 
with the parked calls.

Select the parked call that you would like to answer. You are reconnected 
to the parked station.
Calls that other internal parties have parked are marked "system" in the par-
king list. You can also answer these calls.

or

Double-click the mouse on the line in the call list which contains the parked 
call you wish to take.
You are reconnected to the held party.

When a user picks up a parked call, the park slot number that is now avai-
lable appears on the status bar for ten seconds.

When all parked calls have been answered, the park icon  is removed 
from the system bar.

F6

You can activate a parked trunk only if you are not currently in the talk 
state.

If calls simply "disappear" from your parking list, they may have been 
answered by other internal parties.
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Consultation/Transfer/Conference
Overriding Calls
If an emergency arises and you must speak to a busy internal station, you 
can break into the busy station’s call and speak to the party. You will then 
hear an alerting tone.

In order to prevent parties from breaking into existing calls undetected, the 
message „Override: ...“ appears on the display of the telephone involved 
and the parties are reminded every two seconds by a dual tone that they 
are in an override situation.

1.

Dial the internal station number. You hear a busy signal. As soon as you 
heard the ring tone you are camping on at the other station.

2.

Click the override button in the toolbar. 
You can now speak with the two parties.

or

Click the right mouse button to call the pop-up menu.

Select the Override menu option. 
You can now speak with the two parties.

or

Press the ÷ key on the keyboard. 
You can now speak with the two parties.

or

Press the "F7" button (this must be configured).
You can speak to both parties.

Click the Clear button to leave the call. The other parties remain intercon-
nected.

Overriding Do Not Disturb
Prerequisite: You are authorized to override do not disturb (can be confi-
gured by system administrator).

You urgently need to reach an internal station that has activated do not dis-
turb.

Dial the internal station number. You hear a busy signal. After a brief wait, 
the system automatically overrides do not disturb. You hear a ring tone and 
the destination telephone starts ringing.

÷

F7
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Consultation/Transfer/Conference
Display Suppression
You can prevent the attendant console’s station number or name (for ex-
ample, Switchboard) from appearing on the called party’s display (not for 
internal calls). You must activate this display suppression before dialing; it 
then remains activated until you cancel it.

Activating Display Suppression

Call the pop-up menu. 

Select the Privacy on/off menu option. The privacy on symbol  appears 
in the system bar.

If you now call external party, neither the station number nor the name of 
the attendant console will appear on his or her display.

Deactivating Display Suppression

Call the pop-up menu. 

Select the Privacy on/off menu option. The privacy on symbol  is 
removed from the system bar.

The next time you place an external, your station number or name will ap-
pear on the called party’s display.
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Reaching Parties More Effectively
Reaching Parties More Effectively

Callback
When you cannot reach specific parties, you can send them callback re-
quests to save yourself from attempting additional calls.

1.

Enter the station number and press Enter to confirm your entry. 
The station cannot be reached.

2.

Click the callback button in the toolbar. The callback icon  appears in the 
system bar. 
Your callback request is sent to the called station.

or

Call the pop-up menu.

Click the Callback menu option with the left mouse button. The callback 
icon  appears in the system bar. 
Your callback request is sent to the called station.

or

Press the "F10" button (this must be configured).

The system automatically calls back when:

• The called party hangs up.

• The called party returns and has conducted a call.

• The called party displays his or her messages and responds to the call-
back request.

When you answer the callback, you first will hear a dial tone and then the 
other party will be called.

F10

You can store up to ten callback requests.
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Reaching Parties More Effectively
Displaying and Canceling Callback Requests

You can display and cancel callback requests that you have already issued.

Call the pop-up menu.

Click the Callback menu option with the left mouse button. This option 
appears only if you have issued callback requests.

The call display is replaced by the Callback dialog box, softkeys and opera-
ting keys are masked in:

Using the ,  and  buttons, you can retrieve and cancel 
callback requests from a menu.

Click the Back button in the Callback dialog box to return to the call display.
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Reaching Parties More Effectively
Paging
You can issue a speaker announcement to specific groups through your te-
lephone. These groups can be made up of telephones and speaker sys-
tems; they are configured and assigned group numbers by the system 
administrator. These group numbers must be set to "active" mode in the 
Attendant P Office Æ page 93.

Select the Paging option from the menu bar to open a pull-down menu 
with the paging groups.

Select the group that you want to page. 
The group number is dialed automatically. You can now make your an-
nouncement.

The Paging menu option appears in the menu bar only if paging 
groups have been activated in the Settings window.
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Reaching Parties More Effectively
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Messages
Internal stations can send one another predefined, brief messages.

Sending a Message

Click the message button in the toolbar.

The following dialog box is displayed:

Enter the number of the internal station to which you want to send a 
message and click OK to confirm your entry.

The call display is replaced by the box "Send message", softkeys and ope-
rating keys are masked in:

Using the ,  and  buttons, you can display a menu and se-
lect from among ten predefined, brief messages:

0 = Please callback
1 = Someone is waiting
2 = Appointment 
3 = Urgent call
4 = Do not disturb
5 = Fax waiting
6 = Dictation please
7 = Please come see me
8 = Please make copies 
9 = Redy to depart

The brief messages listed here may differ from the messages actually 
stored in your system.

As soon as you confirm the option„Send“ in the menu, the message is 
sent.
Click the Back button to stop scrolling in the box „Send message“ and re-
turn to the call display.



Reaching Parties More Effectively
Receiving a Message
If messages are waiting for you, the view messages icon  will appear 
in the system bar.

Call the pop-up menu.

Click the View messages menu option with the left mouse button. 

The call display is replaced by the box for viewing messages, softkeys and 
operating keys are masked in:

Using the ,  and  buttons, you can view and delete the 
messages received from a menu.

Click the Back button in the box for displaying messages to return to the 
call display.

Transferring an External Trunk
You can transfer an external trunk to an internal user who is not authorized 
to set up outgoing external calls, thus enabling this party to set up an ex-
ternal call independently.

Prerequisite: You are talking to a party who does not have direct trunk ac-
cess.

Click the Transfer trunk button.

Click the Clear button. You are now available to answer other calls.

Parties without direct trunk access must enter the external code be-
fore dialing an external number.
56



Reaching Parties More Effectively
Releasing an External Trunk
You want to place an urgent external call and receive a busy signal because 
no external trunk is available. You can select a busy trunk and disconnect 
the call on this trunk to make the trunk available for your call.

Keep in mind that this function disconnects calls in progress and should be 
used only in dire emergencies.

Releasing a Busy Trunk

You wish to dial an external station number but already hear a busy signal 
before you dial.

Click the release trunk icon in the toolbar.

The call display is replaced by the dialog box for releasing a trunk, softkeys 
and operating keys are masked in:

Using the ,  and  buttons, you can select and release an 
external trunk from a menu.

Click the Back button in the box for releasing a trunk to return to the call 
display.

Now enter the station number and press Enter to confirm your entry. The 
station is dialed via the released trunk.

If your system is not configured for releasing an external trunk, the 
release trunk button will not appear in the toolbar.
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Reaching Parties More Effectively
Radio Paging (PSE) (Not for U.S.)
If you call an internal station and cannot reach the party at his or her work-
station, you can call the absent party using the radio paging equipment.

Prerequisite: radio paging must be programmed in the system.

Call the pop-up menu.

Select the Personal search menu option.

The following dialog box is displayed:

Enter the desired party’s station number (for example, his or her pager 
number) and press Enter to confirm your entry.

The call display is replaced by the paging dialog box, softkeys and operating 
keys are masked in:

Using the ,  and  buttons, you can display a menu and 
enter a message (for example, a station number) for the party and page 
this party.

Click the Back button in the paging dialog box to return to the call display.

If the party paged does not respond or if the radio paging equipment shuts 
off after a certain period of time, you can cancel the page by clicking the 
Clear button.
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Forwarding Calls
Forwarding Calls
You can forward both internal and external calls to various destinations (in-
ternal or external telephones) (whether external destination is possible de-
pends on system configuration).

Activating Call Forwarding

Click the call forwarding button in the toolbar. 

The following dialog box is displayed:

Enter the station number of the call forwarding destination (internal or ex-
ternal telephone) and click OK to confirm your entry.

Call forwarding is activated and the call forwarding icon  appears in the 
system bar.

Deactivating Call Forwarding

Click the call forwarding button in the toolbar. 

Call forwarding is deactivated and the call forwarding icon  is removed 
from the system bar.

If you activate call forwarding during a call and another call is current-
ly waiting (call waiting), the waiting call is forwarded.
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Night Answer
Night Answer
Night answer is activated when your attendant console is unattended (for 
example, when the office is closed). External calls are forwarded to an in-
ternal night destination (such as the security officer) that you select. The 
system administrator can configure whether or not the Attendant P will be 
authorized to activate night answer.

You can enter and select from among up to eight different internal night 
destinations.

Entering a Night Destination
From the File menu, select the Settings option to open the Settings 
window.

Select the Night destinations tab.

Enter the possible internal night destinations in the text boxes.

Click the OK button to confirm your entries.

Click the Cancel button to return to the attendant monitor.

To select a night destination, click the Change night dest. option in the
Edit menu Æ �HNL 94 and click the Night service button to acti-
vate it Æ page 62.
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Night Answer
Selecting a Night Destination
You can select which night destination (from among up to eight internal 
night destinations) will answer incoming calls. To do this, either select a 
predefined night destination Æ page 60 or enter one manually.

Predefined night destination

From the Edit menu, select the Change night dest. option. The following 
pull-down menu appears, from which you can select a night destination. 
The following pull-down menu appears:

Select a night destination. The night destination selected is identified by a 
check mark. 

After you activate the nicht service Æ page 62, all calls are forwarded to 
this night destination.

Entering a night destination manually

Select the Change night dest. option from the Edit menu. The following 
pull-down menu appears:

Select the "Manual input" option.

The following window appears:

Enter the night destination number and click OK to confirm.

To select the night service programmed in the system by the system ad-
ministrator, enter an asterist (*) for the night destination.

After you activate the night service Æ page 62, all calls are forwarded to 
this night destination.
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Night Answer
Activating Night Answer
Click the night answer button in the toolbar. 

or

Call the pop-up menu. 

Select the Night answer menu option.

The night icon  appears in the system bar and call forwarding to the 
night destination is activated.

Deactivating Night Answer
Click the night answer button in the toolbar. 

or

Call the pop-up menu. 

Select the Night answer menu option.

The night icon  is removed from the system bar and call forwarding to 
the night destination is deactivated.

You must still answer any waiting calls in the call display. Any new 
calls are forwarded to the night destination.
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Notebook
Notebook
In the notebook, you can enter and save any notes, such as additional pho-
ne numbers or notes regarding a phone call. If you save a new entry under 
an existing file name, the new entry is appended to the end of the existing 
one (this can be useful if you are logging multiple calls).

Opening the Notebook

From the Window menu, select the Notebook option.

The Notebook window is displayed.

Using the standard Windows symbols, you can save, open and print the 
notebook files.
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Call Detail Recording for Individual Calls
Call Detail Recording for Individual Calls
When a party using an internal telephone (one that is accessible to the pu-
blic, such as a pay phone) terminates a chargeable call, the call charges can 
be displayed on the Attendant P console. The Callbox button then appears 
above the Hold button in the attendant monitor. However, the service tech-
nician must have configured the pay phone function in the system.

Click the Callbox button in the attendant monitor.

The call display is replaced by the box for displaying charges:

Using the ,  and  buttons, you can select the internal sta-
tion from a menu and display, print or delete the call charges incurred and 
the call duration.

Click the Back button in the box for displaying charges to return to the call 
display.
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Programming/Changing Repdial Keys
Programming/Changing Repdial Keys
You can program the station numbers or codes you use the most on the 
ten repertory dial keys. A sequence of codes can be used to control a voice 
mail system or an answering machine or activate functions on the commu-
nication server (such as entering "#82 to display the caller list).

You can program repertory dial keys (up to ten) for frequently dialed station 
numbers. You must configure these keys before you can use them.

From the File menu, select the Settings option to open the Settings 
window.

Select the Repdial keys tab.

In the text boxes, enter the names and station numbers of the stations 
desired.

Click OK to confirm your entries.

Click the Cancel button to return to the attendant monitor.

You can now reach your parties directly via the repdial keys.

From the menu bar, activate the Repdial keys menu Æ page 36 to access 
the pull-down menu with the repdial keys.

The Repdial keys option appears in the menu bar only if you have 
configured repertory dial keys in the Settings window.
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Electronic Directory (ETD)
Electronic Directory (ETD)
The electronic directory provides you with a convenient means of sear-
ching for stations and dialing the numbers. You can also display detailed in-
formation on the stations. 
In the default configuration, a database for the ETD is loaded when the 
Attendant P is started up.

Starting the ETD
To start the ETD, select the Directory option from the Window menu.

or

Click the directory button in the toolbar.

The main window of the directory is now displayed containing all the stati-
ons in the directory with their data.

Record

Provide station num-
ber for dialing

Data fields

Edit record Generate new 
record

Return to 
attendant mo-
nitorr
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Electronic Directory (ETD)
Searching for a Station
You wish to call Mr. Adams. The caller wants to be connected to a certain 
party (for example, Mr. Adam). However, you do not know Mr. Adam’s sta-
tion number.

Enter the first few letters of the name of the party you want to find in the 
traffic display (for instance, Ada) and press Enter to confirm. If the ETD con-
tains the combination of initial letters entered, the directory is automatical-
ly opened.

The first station name in the ETD that matches the initial letters entered is 
highlighted. Select the desired station.

Click the Dial button.

The station number is transferred to the attendant monitor.

Click the General button to dial the station number.

or

Press Enter to dial the stored station number.

When you search the ETD for a station, the first 100 records located 
are displayed. If you do not see the station you are looking for, enter 
a more specific search word.
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Electronic Directory (ETD)
Searching on the Basis of Other Station Data
You can also base a search on other data such as a company, city, postal 
code or station number. The example below uses a company name. 
A search by city, postal code or station number is conducted in a similar 
manner.

From the Find menu, select the Company option.

or

Press F3.

The following dialog box is displayed:

Enter the company desired and click OK to confirm your entry.

If the company is stored in the ETD, the directory opens with a list of the 
parties employed by this company. The first party is highlighted.

F3
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Electronic Directory (ETD)
Adding New Stations
In the directory’s main window, click the New entry button to open another 
window that has two different tabs on which you can enter a new station 
in the ETD.

The window contains the two tabs "General" and "Additional". On these 
tabs you can enter additional data for the station.

General
On the "General" tab you can enter the user’s name, company, address and 
various telephone numbers.
When calls are made by way of the telephone directory Æ page 38, the 
number is displayed in the "Station number" field (default setting) and then 
dialed. The four other possible numbers can then also be selected.

Save record Return to 
main
directory 
window

General tab Additional
tab
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Electronic Directory (ETD)
Additional
You can use the "Additional" tab in order to enter further data, for example 
the user’s department or corporate rank or several lines of notes, e.g. de-
tails of the company’s business hours.

Click the save icon to save the data.

Click the Cancel button to return to the directory’s main window 
Æ page 66. The new station and its  data are displayed here.

Click the Cancel button in the directory’s main window to exit the ETD and 
return to the attendant monitor.

If you click the Cancel button without saving the record, the record 
is lost and you are returned to the directory’s main window.
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Electronic Directory (ETD)
Editing an Entry
Click the Edit button in the directory’s main window to open another win-
dow with two different tabs on which you can modify the information for 
the selected party.

From the directory’s main window, select the party whose entry you would 
like to modify.

Click the Edit button. 
Another window is displayed with two different tabs on which you can mo-
dify the party’s data.

Click the save icon to save the data.

Click the Cancel button to return to the directory’s main window 
Æ page 66. The new station and its data are displayed here.

Click the Cancel button in the directory’s main window to exit the ETD and 
return to the attendant monitor.

Return to 
directory’s 
main 
window

Delete 
record

Save record

If you click the Cancel button without saving the record, the record 
is lost and you are returned to the directory’s main window.
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Starting the telephone directory CD
Starting the telephone directory CD
A telephone directory CD can be started by way of the "telephone directory 
CD" button in the main window of the Attendant P.
The precondition is that the telephone directory CD has been integrated 
into Attendant P.
For more information on integration of the telephone directory CD func-
tion, please contact your service technician.

Operation of the telephone directory CD varies according to the telephone 
directory CD software which is used.
In order to use the telephone directory CD, please read the documentation 
supplied with the telephone directory CD software.

Using a number on the telephone directory CD
The number located on the telephone directory CD is transferred by copy-
ing it and then entering it in the traffic display of the Attendant P.

Use the mouse to mark the wanted number in the telephone directory CD 
program.

Press "Ctrl" and "C" to place the data in temporary storage.

Position the mouse cursor in the "Number" field in the traffic display.

Press "Ctrl" and "V" to copy the data from temporary storage to the traffic 
display.

Ctrl C+

Ctrl V+
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Opening search window for LDAP server
Opening search window for LDAP server
The search function within the LDAP server is activated with the "Search 
window for LDAP server" button in the main window of the Attendant P.
The precondition is that this search function has been integrated in the 
Attendant P. For more information on the integration of this search func-
tion, please get in touch with your service technician.
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Emergency Operation
Emergency Operation
When you exit the Attendant P or in the event of an application failure, the 
Attendant P changes over to emergency operation. All the features of your 
telephone system are retained and you can continue to execute all swit-
ching functions from your optiset E advance plus/comfort or memory sys-
tem telephone, provided that it is connected to your PC via the control/data 
adapter.
If your PC is connected to the communications platform via the UP0/E PCI 
card, you cannot perform any switching functions during emergency ope-
ration. To continue to operate the system with limited switching functions, 
the system administrator must have configured it accordingly (such as set-
ting up an emergency telephone in the intercept group).

To return to your PC attendant console, restart the Attendant P program 
Æ page 12.

System networking via LAN (PC network)
74



Special Functions in the LAN (PC Network)
Special Functions in the LAN (PC Network)
If your Attendant P is operating in a HiPath AllServe environment, multiple 
communications platforms are interconnected via a LAN (Local Area Net-
work, e.g. proprietary PC network). Your telephone calls are conducted via 
the LAN (PC networks).
If this is the case, an additional busy lamp field entitled "Network" appears 
under the "BLF" window. 

Busy Lamp Field in HiPath AllServe 
In this additional busy lamp field for HiPath AllServe, a further 240 status 
buttons are arranged in two tabs for stations which can be accessed via 
LAN. These status buttons have the same meanings and functions as the 
status buttons of the standard busy lamp field Æ page 23.

Installing and Configuring the 
Attendant P

Please note that in the case of the "Network" busy lamp field for Hi-
Path AllServe, the display is only enabled in telephone number mo-
de.

Status key
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Special Functions in the LAN (PC Network)
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Installing and Configuring the Attendant P
Installing and Configuring the Attendant P
The second section of this manual first tells you how to install the Attendant P attendant 
console hardware and then describes the installation and configuration of the Attendant P 
switching program.

Before installing the Attendant P hardware and software carefully read through this 
section.
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Installing the Hardware
Installing the Hardware
You have two options for connecting the Attendant P
to your PC:

• Via the optiset E control/data adapter and the optiset E advance 
plus/comfort or memory system telephone.

• Via the UP0/E PCI card with handset cradle and handset.

Before beginning installation, make sure that your system meets the re-
quirements listed below:

System Requirements
• PC for Attendant P without any other applications:

133 MHz Pentium with 16 MB RAM 
• PC for Attendant P with call charge applications or other applications:

300 MHz Pentium III with 32 MB RAMSuper VGA with 800x600 pixel 
resolution

• Minimum screen resolution of 1024 x 768 pixels
• Sound card with speaker for ringer signaling
• Microsoft-compatible mouse
• Operating system Windows®95, Windows®98, Windows®ME,

Windows®2000 or Windows®NT
(operation under Windows®2000 only by way of optiset E control/data
adapter in conjunction with optiset E system telephone advance plus/
memory/conference)

• Hicom 150 E/H, HiPath 3000 or HiPath AllServe
• 3.5 inch diskette drive
• CD-ROM or DVD drive
• Free RS-232 interface (COM ports 1 – 4) for optiset E control/data ad-

apter with optiset E advance pluls/comfort, memory, advance confe-
rence/conference system telephones 
Alternative: Free long PCI slot for UP0/E PCI card with handset cradle 
and handset or with headset
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Installing the Hardware
General Instructions
The optiset E system telephones and adapters meet with the relevant con-
formity and safety regulations (CE).

• Do not expose devices to direct sunlight or any other sources of heat.
• Protect devices from moisture and penetration by liquids.
• Never insert objects in openings in the device.
• Operate optiset E local power supplies only at the specified line 

voltage.
• Use only accessories recommended by Siemens.

Before installing the hardware, back up the data on your PC (see the ope-
rating instructions for your operating system or those supplied by your PC 
manufacturer).

Installing the Attendant P via the optiset E control/
data adapter with an optiset E system telephone
The optiset E control/data adapter allows you to connect a PC to your com-
munication system via a system telephone (optiset E memory, advance 
plus/comfort, advance conference/conference). This means that you can 
also perform all switching functions from your PC.

1. Make sure that the product package contains all of the following items:
– optiset E control/data adapter
– optiset E advance plus/comfort, memory, advance conference/confe-

rence system telephone
– Serial connecting cable
– One installation CD-ROM for Attendant P
– Installation instructions for optiset E control/data adapter
– Attendant P User and Installation manual

2. Unplug the subscriber line from the optiset E telephone and place the 
phone on a soft surface with the key field facing down.

3. Hold the optiset E adapter with the edge connector downward and in-
sert it into one of the two slots on the bottom of the optiset E telepho-
ne with the two tabs in the two slits.

4. Gently press the adapter with its edge connector into the socket con-
nector up to the stop.

5. Check which COM port on your PC is free (usually COM2). Information 
on the PC’s serial interfaces can be found either in the operating in-
structions for your operating system or the manual from your PC man-
ufacturer. If you do not have a free COM port, you can configure addi-
tional COM ports in your PC (for example, COM3 and COM4) by 
installing an additional interface card (available from your PC dealer).
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Installing the Hardware
6. Connect the free COM port to the port on the back of the optiset E con-
trol/data adapter using the serial cable provided.

7. If applicable, connect the headset to the optiset E control/data adapter.

8. Reconnect the subscriber line to the optiset E telephone.

9. Start your PC and install the Attendant P software Æ page 84.

Installing the Attendant P via a
UP0/E PCI Card with Handset Cradle and Handset

The UP0/E PCI card is a state-of-the-art, plug-in PCI card that allows you to 
connect a PC to your communication system as though it were a system 
telephone. This means that you can also perform all switching functions 
from the PC.

For installation, the card requires a virtual COM port, an interrupt (IRQ) and 
an I/O address. Because the card is a PCI card, the system automatically 
assigns it the interrupt and the I/O address. 
The virtual COM port is a COM port installed over and above your existing 
COM ports by means of the supplied software. This virtual COM port has 
no external port. Normally, the software configures the virtual COM port as 
COM3 because most PCs are equipped with two COM ports. However, 
you can also change it to COM4 if COM3 is already being used.

Installation Procedure

1. Make sure that the product package contains all of the following items:
– One UP0/E PCI card
– One handset cradle with line cord to UP0/E PCI card
– One handset with line cord to handset cradle
– One driver disk for UP0/E PCI card
– One installation CD-ROM for Attendant P
– Attendant P User and Installation manual

2. Disconnect the PC from the power supply network and open the hou-
sing (also refer to operating instructions from PC manufacturer).

3. Select a free, long PCI slot and remove its cover from the housing back 
panel (also refer to operating instructions from PC manufacturer).

4. Before installing the card, create a ground connection by touching the 
computer housing; this is necessary because the card is highly sensiti-
ve to static electricity.

If you are using Windows®2000, installation is only possible by way 
of the optiset E control/data adapter in conjunction with an optiset 
E system telephone Æ page 78.
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Installing the Hardware
5. Remove the UP0/E PCI card from its antistatic case; plug it into the se-
lected PCI slot and secure it in place (also refer to operating instructions 
from PC manufacturer).

6. Connect the UP0/E PCI card to the communication system as described 
under PIN assignments Æ page 83.

7. Connect the handset and, if applicable, the headset to the handset cr-
adle and connect the handset cradle to the UP0/E PCI card as described 
under PIN assignments Æ page 83.

8. Close the PC and reconnect it to the power supply network. 
The yellow LED on the UP0/E PCI card must flash in one-second inter-
vals

9. Start your operating system.
The operating system informs you that new hardware has been found 
(Multimedia PC Card) and asks you to install the drivers for the UP0/E 
PCI card.

10. Insert the disk (or CD-ROM) with the drivers and enter the path to the 
file with driver information (pcipcvf.inf) (for example: a:\). 
The drivers are copied to your Windows system directory and startup 
of the operating system is resumed.

11. Once the drivers have been copied, check whether the card is correctly 
installed in your system:
– From the Start menu, select Settings and then Control Panel. 
– Double-click the System icon and click the Device Manager tab. 

The additional, virtual COM3 port must be configured under Ports 
(COM & LPT). If COM3 is already being used on your PC, you must 
change the virtual COM port from COM3 to COM4 Æ page 82

– Under the Device Manager tab, open the Computer icon. Check 
whether an interrupt and I/O address were assigned to the UP0/E PCI 
card using the Interrupt request (IRQ) and Input/output (I/O) options.

12. Install the Attendant P software Æ page 84.
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Installing the Hardware
Changing COM3 to COM4

1. From the Start menu, select Settings and then Control Panel. 

2. Double-click the System icon and click the Device Manager tab. 

3. Double-click the System devices icon.

4. Select the UP0/E PCI card and click the Properties button.

5. Open the UP0/E PCI card properties window. Under the Status tab, click 
the Service Information button.

6. Enter the system code 77777 and confirm your entry. Another window 
opens in which you can change COM3 to COM4.

7. Confirm your entry and restart your operating system to apply the chan-
ges.

Uninstalling the Drivers

If you need to uninstall the UP0/E PCI card drivers:

1. From the Start menu, select Settings and then Control Panel.

2. Double-click the System icon and select the Device Manager tab.

3. Select the UP0/E PCI card and click the Remove button.

4. In the next window, click OK to confirm.

Updating the Drivers

If an updated driver version exists for the UP0/E PCI card, your system ad-
ministrator can update your system without having to change the hardware 
or software. The following drivers must be copied from the update disk or 
update CD-ROM to your Windows system directory
(e.g.: c:\windows\system):

– compcvf.vxd
– pcipcvf.vxd
– pcvfprop.dll

This overwrites any earlier driver versions. The updated drivers are not valid 
until you restart Windows.
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Pin Assignments

Two 8-pin and two 6-pin modular phone  jacks are located on the back of 
the UP0/E PCI card:

• Jack SYS (8-pin): Connection to the communication system
• Jack HA (8-pin): Port for handset cradle and handset
• Jack OUT (6-pin): Port for external recording equipment
• Jack IN (6-pin): Not used

In addition, one yellow LED and one red LED are on the back of the card 
to indicate the following UP0/E PCI card statuses:

• Red LED illuminated: Card error
• Yellow LED flashing: Card in operation
• Yellow LED illuminated: Data being transferred between card and com-

munication system
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Installing the Software
1. Switch on the attendant console PC (if it is not already on) and start 

your operating system Æ page 78.

2. Insert installation CD-ROM.

3. From the Start menu, click Run and select the setup.exe file on the CD-
ROM or DVD drive.

The Attendant P installation program now starts the InstallShield® Wi-
zard, which guides you through the rest of the installation process.

After the InstallShield® Wizard has started, the Welcome window is 
displayed.

4. Click the Next button to confirm.

The User Information dialog box appears.

During installation make sure that no other applications are 
open. Use the CTRL-ALT-DEL function to bring up the “Close pro-
gram” window and close all programs except explorer and SYS-
TRAY.

You can exit installation at any time by clicking the Cancel button. 
Any files that were already copied to your hard disk are removed.
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5. Enter a name or designation and the name of your company and click 
the Next button to confirm your entries. 
The Choose Destination Location window appears.

6. You can click Browse to select another directory. 
The Choose Directory dialog box appears.
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7. After selecting the new directory, click OK to confirm your selection. 
You are returned to the Choose Destination Directory window. Click the 
Next button to confirm your selection. 
The Select Program Folder dialog box appears. 

8. Select a name for the program folder that will be added to the Pro-
grams menu in the Windows Start bar. This is how you will start the 
Attendant P in the future. Click the Next button to confirm your selec-
tion. 
The Start Copying Files window appears..
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9. When you click Next, the installation program copies all the necessary 
files to the directory selected. The next status box shows you how the 
copy procedure is progressing.

10. When the installation CD-ROM has been read in, the message “Setup 
is creating Icons” is displayed.

The program folder with the Attendant P program is opened.

Finally, the Setup Complete window appears.
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11. Click the Finish button to confirm. 
Installation has been completed.
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Configuring the Attendant P

Entering Settings
When you have finished installing the Attendant P program on the atten-
dant console, start the program. 
The first time you start Attendant P, a window automatically opens in 
which you can select the language for Attendant P.

Click OK to confirm your selection. The Settings window automatically 
opens. You can configure the Attendant P using this window.
(To access this window, select the Settings option from the File menu.)

Enter data under the seven tabs using the following procedures.

Whenever a change is detected in the system configuration (via As-
sistant or Symac) after start of the Attendant P or during its opera-
tion, the Attendant P is automatically updated. This procedure is in-
dicated in the status bar by the message “Please wait.”
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Connection
Select the PC COM port needed by the UP0/E PCI card (COM3 or COM4) 
or the port to which the optiset control/data adapter of a system telephone 
is connected (usually COM2).

If a Hicom Attendant B Office braille console (available only for certain 
countries and languages) is installed on the PC, you also must enter the 
COM port to which the keyboard is connected and select the Activated op-
tion.
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Calls
In the first text box under the Calls tab, define the number of calls (thres-
hold value) above which a visual warning will be issued. At this point, the 
color of the bar indicator for all pending calls in the call display changes 
from green to red.

In the other text boxes under this tab, specify the paths to the wave files 
(included in the software package) for ringer signaling on the PC. You can 
choose from among six different ringer signals for external, internal and 
personal calls.
When you select the Activated option, the ringer signal is played over one 
or two additional speakers that are connected to the sound card when you 
receive an incoming call.
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System
Under the System tab, you can enter general settings for the attendant 
console.

• System Update:
The System Update button allows you to request the data needed by 
the Attendant P from the system.

• Pause character:
You can define a character which you will use to generate a deliberate 
dial pause, for example after dialing the external code (not necessary 
for digital exchanges).

• Trunk seizure with: 
For Attendant P Release 1.0 only: Enter the external code for the "trans-
fer trunk" function here.
This no longer applies in Attendant P Release 2.0 and later.

• Number redial only for external numbers:
This option allows you to restrict the number redial list to external calls.

• Deactivate night answer at start:
If you select this option, night answer is automatically deactivated (if it 
was previously activated) when the Attendant P is started.

• Activate silent call at start: 
If you select this option, the telephone ringer, and thus the ringer signal, 
is automatically deactivated when the Attendant P is started (does not 
apply if you have a UP0/E card.

• Call detail file:
All chargeable phone calls and their values are stored in the call detail 
file. Enter the path to the call detail file. All chargeable phone calls and 
their values are stored here.
The call charges are recorded in the file only if the system administrator 
has configured call detail recording in the system. If it is configured, you 
will see a check mark next to the Activated option.
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Paging
Under the Paging tab, you can configure the existing groups in the commu-
nication system as active announcement groups. 

From the Existing groups box, select the groups that you want to be able 
to reach with a speaker announcement and transfer them to the Active an-
nouncement groups box.

The Paging menu option is now displayed in the Attendant P menu bar. 
This menu option allows you to issue speaker announcements to the con-
figured groups.
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Repdial Keys
Use the Repdial keys tab to program the ten station numbers or codes you 
use the most on repertory dial keys. A sequence of codes can be used to 
control a voice mail system or an answering machine or activate functions 
on the communication server (such as entering "#82 to display the caller 
list).

Under the Repdial keys tab, you can configure repertory dial keys for ten 
frequently used station numbers or codes (such as for controlling a voice 
mail system or answering machine).

In the input fields, enter either the name and station number of the station 
your wish to reach or the name and code for cintrolling a voice mail system 
or answering machine.

The Repdial keys menu option is now displayed in the Attendant P menu 
bar. This option provides you with a pull-down menu from which you can 
call the configured stations and access the configured functions directly.
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Night Destinations
You can enter up to eight different night destinations under the Night des-
tinations tab. You can then select the Change night dest. option from the 
Edit menu to choose a night destination and activate it by clicking the night 
answer button in the toolbar. All calls are then forwarded to this 
destination.
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BLF

You can enter the settings for the busy lamp field (BLF) under the BLF tab. 
The BLF consists of two to four groups, each containing 240 status keys 
that you can use to call system users directly. You can assign an internal 
station to each status key, and each keys display either the number (in sta-
tion number mode) or the name (in name mode) of the internal station as-
signed to it.

• In station number mode: two groups of 120 stations each.
• In name mode: four groups of 60 stations each.

Use the BLF tab to set the following modes for the BLF:

• Station number mode: The Display name option is not selected. The 
BLF displays the numbers of the internal stations. This is the default 
mode.

• Name mode: The Display name option is selected.
The BLF displays the names of the internal stations to which the num-
bers were assigned in the system. To switch to name mode, you must 
first import the names from the system using the System Update 
Æ page 92 and Set BLF buttons.

When you click the Set BLF button at the top of the tab, the system first 
removes all station numbers from the BLF and then enters the stations 
configured in the communication system, sorted by number. For example, 
if a station configured in the BLF is assigned another station number, its 
station number in the BLF is not replaced until you update the BLF. 
The Set BLF button is active only in station number mode.

Special features must be taken into consideration if your 
Attendant P operates with HiPath AllServe (system networking via 
PC network) Æ page 75!
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If you want the busy lamp field to load automatically whenever Attendant P 
starts up, select the BLF activated option in the middle of the tab.

You can decide whether the label (foreground) or the background of the sta-
tus keys in the BLF will change color when a station is called or is busy.
You can also display the labels on the status keys in bold characters.

In the bottom section of the tab, you can change various color settings for 
the the status keys:

• Color for internal station busy:
Status key color when the internal station is busy.

• Color for external station busy:
Status key color when the external station is busy.

• Color station is called: 
Color of the status button when the station is being called.

• Color group 1: 
Background color for Group 1 tab.

• Color group 2: 
Background color for Group 2 tab.

Example: If a status button has a gray background, the station if free. If the 
background is dark red, the station is busy with an external call; if it is light 
red, the station is busy with an internal call. If the station is being called, 
the background of the status button turns yellow.

The first time you start the Attendant P, you must click the Set BLF 
button to transfer all system users to the BLF.
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Saving the Settings
Once you have entered your settings in the Settings window, you must 
save your entries in order for the changes to be applied.

In the Settings window, click OK to confirm your entries.

When you return to the attendant monitor, the message Please wait may 
appear in the status bar of the attendant monitor while Attendant P is 
being updated with the new settings. As soon as the update operation has 
been completed, the message System ready is displayed. The Attendant P 
is ready for operation.

Click the Back button to return to the attendant monitor without save 
the changes.
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Configuring the Electronic Directory
The electronic directory is a database based on Microsoft Access 2.0, so it 
is compatible with other directory files such as Smartset. 
You can also use this database concurrently with several Attendant Ps. Ple-
ase contact your service technician in such cases.

In the default configuration, an existing database for the directory is loaded 
when the Attendant P is started. You can add new stations to the databa-
se.

Starting the ETD
To start the ETD, select the Directory option from the Window menu.

or

Click the directory button in the toolbar.

The main window of the directory containing all the stations in the directo-
ry and their data is now displayed.

In order to modify the number of data records displayed in the main ETD 
window, please consult your service technician.

Record

Provide station num-
ber for dialing

Data fields

Edit record Generate new 
record

Return to 
attendant mo-
nitorr
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Adding New Stations

The "New entry" button in the main window of the telephone directory can 
be used to open a further window with two different tabs by means of 
which you can add a new user to the ETD.

The window contains the two tabs "General" and "Additional". On these 
tabs you can enter additional data for the station.

General

On the "General" tab you can enter the user’s name, company, address and 
various telephone numbers.
When calls are made by way of the telephone directory Æ page 38, the 
number is displayed in the "Station number" field (default setting) and then 
dialed. If you wish to alter this default setting, please contact your service 
technician.

Save record Return to 
main
directory 
window

General tab Additional
tab
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Additional

You can use the "Additional" tab in order to enter further data, for example 
the user’s department or corporate rank or several lines of notes, e.g. de-
tails of the company’s business hours.

Click the save icon to save the data.

Click the Cancel button to return to the directory’s main window 
Æ page 99.
The new station and its most important data are displayed here.

Click the Cancel button in the directory’s main window to exit the ETD and 
return to the attendant monitor.

Backing up the ETD Database
At regular intervals, you (or the system administrator) should backup the 
file in which the Attendant P stores the electronic directory data.

This file is located in the root directory for the Attendant P (for example, un-
der C:\Program Files\Attendant P) and is called set3.mdb.

Copy this data to the backup directory of your choice.

Error Correction in Attendant P

If you click the Cancel button without saving the record, the record 
is lost and you are returned to the directory’s main window.

If you wish to change the storage location of the current ETD data-
base, please get in touch with your service technician.
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Error Correction in Attendant P
This section discusses the questions and problems that users most often encounter when 
installing the UP0/E PCI card.
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Frequently Asked Questions

Do I have to configure the UP0/E PCI card?
Because the UP0/E PCI card was developed for the PCI bus, you simply 
need to install it in your PC and the system will automatically assign this 
card the necessary interrupt and I/O address.

However, problems may arise in some computers that use the PCI bus to-
gether with the ISA/EISA bus. In this case, you must use the setup pro-
gram in the computer’s BIOS to assign separate interrupts to the ISA/EISA 
slots and the PCI slots; otherwise, the computer will not detect the card 
(see documentation on the setup program for your computer).

Which PCI slot should I use for the UP0/E PCI card?
You can install the UP0/E PCI card in any free, long PCI slot.

Is the UP0/E PCI card compatible with PCI spec 2.1?
The UP0/E PCI card is compatible with PCI spec 2.1.

Which interrupt should I use for the UP0/E PCI card?
Because the UP0/E PCI card is a PCI card, you usually do not have to select 
an interrupt. It is configured by the system. If this is not the case, you must 
configure the interrupt manually. To configure the interrupt manually, insert 
a jumper on the motherboard or set an interrupt in the motherboard’s 
BIOS. In either case, you can select any interrupt that is not being used by 
another ISA/EISA plug-in card. Keep in mind that the interrupt settings on 
your motherboard and in the BIOS must agree.
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Can the UP0/E PCI card share an interrupt with
another PC card (shared interrupts)?
With the UP0/E PCI card drivers, it is possible for the card to share an inter-
rupt with another card.

Nevertheless, this may result in conflicts if the UP0/E PCI card shares an 
interrupt with another PCI card because there is no international standard 
for shared interrupts.

If you have installed another PCI card in your system that does not support 
shared interrupts, ask the card manufacturer for a driver that permits 
shared interrupts or assign the card a different interrupt.

You may also have problems with your operating system if two cards 
attempt to use the same interrupt. The system may suddenly shut down 
or restart for no apparent reason. If this occurs, assign each PCI card a se-
parate interrupt (also see the operating instructions from the PC manufac-
turer or for the motherboard).
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Why won’t my computer work
after I’ve installed the UP0/E PCI card?
With some computers, you must do some additional configuring before 
the PC card will operate correctly:

1. Find out whether you have the latest BIOS version for your mother-
board. If not, obtain it from the PC or motherboard manufacturer (for 
example, via the Internet). A BIOS update should be performed by ex-
perienced personnel only.

2. Check whether the BIOS is configured correctly. In some computers 
that have a PCI bus, the PCI slots must be enabled in the BIOS. This is 
often the case with computers with a Phoenix-BIOS.
– After installing the PC card, connect your computer to the power 

supply network and start the setup program. You can usually access 
this program by pressing a key combination displayed on the screen, 
such as F1+Del or Ctrl+Alt+S.

– Look in the BIOS for PCI slot entries. They can be found in the main 
menu or under Advanced System Configuration. If necessary, 
change the settings:

BIOS System Parameters: Settings:

PCI Slot Number Slot in which the 
PC card is installed.

Master ENABLED
Slave ENABLED
Interrupt Select a free interrupt 

provided by the system
Edge of level Level Triggered Interrupt

(Note: Terms may vary from BIOS to BIOS.)
– Save your settings and exit the setup program. Resume installation.

3. If you have problems with Windows 95/98, replace the UP0/E PCI card 
with another PCI card. When you replace the cards, the BIOS also re-
places the two interrupts assigned to the cards. After a system restart, 
the problem with your operating system may have been eliminated.
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Problem Correction

The Attendant P does not start correctly
• Check whether the UP0/E PCI card (if present) has been assigned an in-

terrupt, an I/O address, and COM3 (or COM4).
• Check whether the drivers for the UP0/E PCI card (if present) were in-

stalled Æ page 81.
• Check whether the UP0/E PCI card (if present) is securely plugged into 

the computer slot.
• Check whether you have too many other programs open.
• Shut down your computer and switch it off and on.

The Attendant P is no longer responding
• Close any 16-bit applications that are open (such as Word 6.0).
• Check whether the HiPath system is still operating by verifying another 

telephone’s operation (the system may have failed).
• Shut down your computer and switch it off and on.

The message Please wait - Trunk error appears in 
the system bar
• Check the connection between the UP0/E PCI card and the handset cr-

adle and between the handset cradle and the handset, or between the 
optiset E data/control adapter and the COM port.

• Check whether the optiset data/control adapter (if present) is correctly 
plugged into the system telephone.

• Check the connection between the UP0/E PCI card and the HiPath sys-
tem or between the system telephone and the HiPath system.

Once the system is correctly connected, the message disappears and the 
Attendant P is again ready for operation.

The busy lamp field is malfunctioning
• If the status button for a station is always red (indicating that the station 

is busy), it may not mean that the station is constantly conducting calls 
but, instead, that the station telephone is defective or was removed 
from the HiPath system. If such is the case, update the busy lamp field 
Æ page 96.

• If the status button for a station is always yellow (indicating that the sta-
tion is being called) and you cannot transfer the call, it may mean that 
you are conducting a call or that you have a call waiting. In such cases, 
you cannot transfer the call.
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The directory no longer contains data
The directory database set3.mdb was moved to another directory or was 
deleted. With your operating system, you can retrieve the unintentionally 
deleted file from the Recycled directory or copy the backup file for the di-
rectory database Æ page 101 back to the Attendant P root directory.

Troubleshooting Using the Trace Button (System Ad-
ministrator Only)
The trace button allows you to store special error codes for reproducible 
errors in a text file that can then be passed on to a service technician at 
Siemens AG (intended for system administrator only).

Configuring the Trace Button

• In the Attendant P root directory, open the vf3.cfg file using any text 
editor.

• Insert the following line under <System>: 
Trace=5

• Save the file and restart the Attendant P. The Trace button now appears 
in the toolbar. 

Click the Trace button in the toolbar to open the error code window. Delete 
any old error codes using the Clear button. Generate the reproducible er-
rors and save the file. The file is saved as trace.txt in the Attendant P root 
directory. Make a backup copy and send the file to the service technician 
for error analysis.
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Important Keyboard Commands
Important Keyboard Commands
You can initiate the most important functions of the Attendant P using the 
keyboard and numeric keypad.

Keyboard

Answer calls.

Dial station number in General trunk group.

Connect calls.

Place calls on hold.

Toggle between two calls.

Park calls.

Disconnect calls.

Dial station number in Private trunk group.

Return to waiting call.

Clear text boxes.

Dial station number.

Activate/deactivate microphone (mute).

Space Bar

Alt A+

Alt B+

Alt H+

Alt M+

Alt P+

Alt S+

Alt V+

Alt Z+

Del.

Pause



Important Keyboard Commands
The function keys on your PC keyboard can have the following functions, 
depending on the configuration of your Attendant P (consult your service 
technician):

Call Help.

Find by name.

• Search for company or
• Hold the call.

• Search for locations or
• Return to the waiting party.

• Search for post code or
• Toggle between two calls.

• Search for telephone numbers or
• Park the call.

• DTMF signaling or
• Override a call.

Activate/deactivate microphone (mute).

Initiate conference.

Activate callback.

Numeric Keypad

Connect calls.

Return to waiting call.

Override calls.

Dial station number.

F1

F2

F3

F4

F5

F6

F7

F8

F9

F10

+

–

÷

Enter
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